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Preface
INTRODUCTION
This chapter contains general information that will be useful to know before using the 
dsPIC® DSC Acoustic Echo Cancellation Library. Items discussed in this chapter 
include:
• Document Layout
• Conventions Used in this Guide
• Warranty Registration
• Recommended Reading
• The Microchip Web Site
• Development Systems Customer Change Notification Service
• Customer Support
• Document Revision History

DOCUMENT LAYOUT
This user’s guide describes how to use the dsPIC DSC Acoustic Echo Cancellation 
Library. The document is organized as follows:
• Chapter 1. “Introduction” – This chapter introduces the dsPIC DSC Acoustic 

Echo Cancellation Library and provides a brief overview of acoustic echo 
cancellation and the library features. It also outlines requirements for a host PC.

• Chapter 2. “Installation” – This chapter provides instructions for installing the 
library files and describes the contents of the source files, include files, demo files 
and archive files.

• Chapter 3. “AEC Demonstration” – This chapter provides a hands-on 
demonstration of acoustic echo cancellation in a working application. 

• Chapter 4. “Application Programming Interface (API)” – This chapter outlines 
how the API functions provided in the dsPIC DSC Acoustic Echo Cancellation 
Library can be included in your application software via the Application 
Programming Interface.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help. 
Select the Help menu, and then Topics to open a list of available on-line help files.
© 2008 Microchip Technology Inc. DS70134D-page 1
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CONVENTIONS USED IN THIS GUIDE
This manual uses the following documentation conventions:

WARRANTY REGISTRATION
Please complete the enclosed Warranty Registration Card and mail it promptly. 
Sending in the Warranty Registration Card entitles users to receive new product 
updates. Interim software releases are available at the Microchip web site.

DOCUMENTATION CONVENTIONS
Description Represents Examples

Arial font:
Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...
Initial caps A window the Output window

A dialog the Settings dialog
A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK
A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>
Courier New font:
Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [  ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

DS70134D-page 2 © 2008 Microchip Technology Inc.
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RECOMMENDED READING
This user’s guide describes how to use the dsPIC DSC Acoustic Echo Cancellation 
Library. Other useful documents include:

dsPIC30F Family Reference Manual (DS70046)
Refer to this document for detailed information on dsPIC30F device operation. This 
reference manual explains the operation of the dsPIC30F DSC family architecture and 
peripheral modules but does not cover the specifics of each device. Refer to the 
appropriate device data sheet for device-specific information.

dsPIC33F Family Reference Manual Sections
Refer to these documents for detailed information on dsPIC33F device operation. 
These reference manual sections explain the operation of the dsPIC33F MCU family 
architecture and peripheral modules, but do not cover the specifics of each device. 
Refer to the appropriate device data sheet for device-specific information.

dsPIC30F/dsPIC33F Programmer’s Reference Manual (DS70157)
This manual is a software developer’s reference for the dsPIC30F and dsPIC33F 16-bit 
MCU families of devices. It describes the instruction set in detail and also provides 
general information to assist in developing software for the dsPIC30F and dsPIC33F 
MCU families.

MPLAB® ASM30, MPLAB® LINK30 and Utilities User’s Guide (DS51317)
This document helps you use Microchip Technology’s language tools for dsPIC® DSC 
devices based on GNU technology. The language tools discussed are:
• MPLAB ASM30 Assembler
• MPLAB LINK30 Linker
• MPLAB LIB30 Archiver/Librarian
• Other Utilities

MPLAB® C30 C Compiler User’s Guide (DS51284)
This document helps you use Microchip’s MPLAB C30 C compiler for dsPIC DSC 
devices to develop your application. MPLAB C30 is a GNU-based language tool, based 
on source code from the Free Software Foundation (FSF). For more information about 
the FSF, see www.fsf.org.
Other GNU language tools available from Microchip are:
• MPLAB ASM30 Assembler
• MPLAB LINK30 Linker
• MPLAB LIB30 Librarian/Archiver

MPLAB® IDE Simulator, Editor User’s Guide (DS51025)
Refer to this document for more information pertaining to the installation and 
implementation of the MPLAB Integrated Development Environment (IDE) software. 
To obtain any of these documents, contact the nearest Microchip sales location (see 
back page) or visit the Microchip web site at:
www.microchip.com.

Microsoft® Windows® Manuals
This user’s guide assumes that you are familiar with the Microsoft Windows operating 
system. Many excellent references exist for this software program and should be 
referenced for general operation of Windows.
© 2008 Microchip Technology Inc. DS70134D-page 3
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THE MICROCHIP WEB SITE
Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:
• Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE
Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.
To register, access the Microchip web site at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.
The Development Systems product group categories are:
• Compilers – The latest information on Microchip C compilers and other language 

tools. These include the MPLAB C18 and MPLAB C30 C compilers; MPASM™ 
and MPLAB ASM30 assemblers; MPLINK™ and MPLAB LINK30 object linkers; 
and MPLIB™ and MPLAB LIB30 object librarians.

• Emulators – The latest information on Microchip in-circuit emulators. This 
includes the MPLAB ICE 2000, MPLAB ICE 4000 and MPLAB REAL ICE.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit 
debugger, MPLAB ICD 2.

• MPLAB® IDE – The latest information on Microchip MPLAB IDE, the Windows® 
Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB SIM simulator, MPLAB IDE Project Manager 
and general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 
the MPLAB PM3 and PRO MATE® II device programmers and the PICSTART® 
Plus and PICkit™ 1 development programmers.

CUSTOMER SUPPORT
Users of Microchip products can receive assistance through several channels:
• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support
• Development Systems Information Line
Customers should contact their distributor, representative or Field Application Engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.
Technical support is available through the web site at: http://support.microchip.com
DS70134D-page 4 © 2008 Microchip Technology Inc.
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DOCUMENT REVISION HISTORY

Revision A (July 2004)
• Initial Release of this document.

Revision B (April 2005)
• Updated to reflect added sample rate conversion functions and corresponding 

demo changes.

Revision C (August 2008)
This revision includes the following updates for version 5.0 of the Acoustic Echo 
Cancellation Library.
This document has been renamed from “dsPIC30F Acoustic Echo Cancellation Library 
User’s Guide” to its new name of “dsPIC® DSC Acoustic Echo Cancellation Library 
User’s Guide”. There has been no change to the Microchip literature number 
(DS70134) other than a revision letter update.
Each chapter has been extensively reworked and reorganized to support all dsPIC 
DSC devices. The previous version of the document contained seven chapters, which 
have been consolidated as described in the following table:

MAJOR UPDATES

Chapter Name Update Description

Chapter 1. “Introduction” The optional accessory kit is no longer available and the related information has 
been removed.

The reference to the user functions has been removed.

The host system requirements section was updated to include the HTML 
browser requirement.

Chapter 2. “Installation” The installation procedure was updated to accommodate the installation CD file 
changes. See Section 2.1 “Installation Procedure”.

The Acoustic Echo Cancellation Library files have been updated and the inc 
folder was renamed to h. See Section 2.2 “Acoustic Echo Cancellation 
Library Files”.

Chapter 3. “AEC Demonstration”
(formerly Chapter 6. Acoustic Echo 
Cancellation Demo)

The dsPICDEM™ 1.1 Plus development board jumper (J9) setting has been 
changed from MASTER to SLAVE. See Section 3.2 “Demonstration Setup” 
and Figure 3-2.

Due to the removal of the optional Acoustic Accessory Kit, the reference to the 
14.7456 MHz oscillator in the Demonstration Setup section has been removed.

The demonstration procedure has been completely rewritten to provide more 
information on the state of operation. See Section 3.3 “Demonstration 
Procedure”.

Chapter 4. “Application 
Programming Interface (API)”
(formerly Chapter 3, same title)

This chapter has been updated with a completely new set of API functions. See 
Section 4.6 “Acoustic Echo Cancellation Library API Functions”.

The information in the chapter formerly known as Acoustic Echo Cancellation 
Algorithm was consolidated and relocated to the Application Programming 
Interface (API) chapter. See Section 4.4 “Library Usage”.

The information in the formerly known Resource Requirements chapter was 
consolidated and relocated to the Application Programming Interface (API) 
chapter. See Section 4.5 “Resource Requirements”.
© 2008 Microchip Technology Inc. DS70134D-page 5
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Revision D (November 2008)
• Updated demonstration file names in Table 2-1
• Updated step 1 in Section 3.3 “Demonstration Procedure”
• Updated text in Section 3.4 “Demonstration Code Description” as follows:

- Si3000CodecInit() has been changed to SI3000_open()
- init_uart() has been changed to UART1_open()
- Updated UART baud rate from ~115200 to ~250000
- Updated text in the first and second sentences of the seventh paragraph to 

clarify codec data buffer interaction with the codec driver
- Updated text in the second and third sentences of the ninth paragraph to 

clarify main loop functionality
• Updated code examples in Chapter 4. “Application Programming Interface 

(API)” to reflect changes to the API functionality
• Added Section 4.2 “Memory Model Compile Options”
DS70134D-page 6 © 2008 Microchip Technology Inc.
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Chapter 1.  Introduction
This chapter introduces the dsPIC DSC Acoustic Echo Cancellation Library. This 
library provides functionality to suppress echo in applications that are susceptible to 
echo. This manual provides information you can use to incorporate acoustic echo 
cancellation capability into your embedded solution. Topics covered include:
• Acoustic Echo Cancellation Overview
• Features
• Host System Requirements

1.1 ACOUSTIC ECHO CANCELLATION OVERVIEW
Acoustic echo cancellation suppresses or cancels echoes generated in applications 
due to a feedback path or coupling between input and output terminals of a system. 
Figure 1-1 shows an example of a speech and telephony system, which is susceptible 
to Acoustic Echo. In this case, the echo is caused due to the acoustic coupling between 
the speaker and microphone at the near-end of the communication link, which results 
in a perceptible and distracting echo at the far-end. In this case, an acoustic echo 
cancellation algorithm running at the near-end, will suppress the echo and improve the 
performance of the system.

FIGURE 1-1: ACOUSTIC ECHO CANCELLATION IN A SPEECH AND 
TELEPHONY APPLICATION

∑
Send Path

+

Adaptive 
Filter

-

Far-End SpeechFar-End Speech
Receive Path

Near-End Speech

Near-End Speech

Echo

Acoustic Echo Canceller

NEAR-ENDFAR-END
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The Acoustic Echo Cancellation library uses a fixed 8 kHz sampling rate and is 
especially suitable for applications such as:
• Hands-free cell phone kits
• Speaker phones
• Intercoms
• Teleconferencing systems
For hands-free phones intended to be used in automotive environments, such as a car 
cabin, this library is compatible with the G.167 Standard for Acoustic Echo 
Cancellation and with other relevant ITU-T standards.
The Acoustic Echo Cancellation (AEC) Library is written almost entirely in assembly 
language and is highly optimized to make extensive use of the dsPIC DSC device 
instruction set and advanced addressing modes. The algorithm avoids data overflow. 
The AEC Library provides an EC_init function for initializing the various data struc-
tures required by the algorithm and an EC_apply function to remove the echo compo-
nent from a 10 ms block of sampled 16-bit speech data. You can easily call both 
functions through a well-documented Application Programmer’s Interface.
The Acoustic Echo Cancellation algorithm is primarily a Time Domain algorithm. The 
received far-end speech samples (typically received across a communication channel, 
such as a telephone line) are filtered using an adaptive Finite Impulse Response (FIR) 
filter, and then subtracted from the near-end input speech signal. The coefficients of 
this filter are adapted using the Normalized Least Mean Square (NLMS) algorithm, 
such that the filter closely models the acoustic path between the near-end speaker and 
the near-end microphone (i.e., the path traversed by the echo). A Nonlinear Processor 
(NLP) algorithm is available to eliminate residual echo.

1.2 FEATURES
Key features of the Acoustic Echo Cancellation Library include:
• Simple user interface – only one library file and one header file
• All functions can be called from a C application program
• Compatible with the Microchip C30 Compiler, Assembler and Linker
• Highly optimized assembly code that uses DSP instructions and advanced 

addressing modes
• Acoustic echo cancellation for 16, 32, 64 or 128 ms echo delays or “tail lengths” 

(configurable)
• Compatible with G.167 specifications for in-car applications
• Audio Bandwidth: 0 to 4 kHz at 8 kHz sampling rate
• Convergence Rate: Up to 47 dB/sec., typically greater than 30 dB/sec
• Acoustic Echo Cancellation: Up to 50 dB, typically > 40 dB
• Can be used together with the Noise Suppression (NS) Library
• Demo application source code is provided with the Library
• NLP attenuation level can be adjusted to suit application requirements
• Acoustic Echo Cancellation adaptation can be force-enabled or disabled by the 

user application
• Run-time control of key algorithm parameters is provided
DS70134D-page 8 © 2008 Microchip Technology Inc.
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1.3 HOST SYSTEM REQUIREMENTS
The Acoustic Echo Cancellation Library requires a PC-compatible system with these 
attributes:
• Intel® Pentium® class or higher processor, or equivalent
• HTML browser
• 16 MB RAM (minimum)
• 40 MB available hard drive space (minimum)
• Microsoft® Windows® 98, Windows 2000, or Windows XP
© 2008 Microchip Technology Inc. DS70134D-page 9
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Chapter 2.  Installation
This chapter describes the various files in the Acoustic Echo Cancellation (AEC) 
Library and includes instructions for installing the AEC Library on your laptop or PC for 
use with dsPIC DSC device programming tools. Topics covered include:
• Installation Procedure
• Acoustic Echo Cancellation Library Files

2.1 INSTALLATION PROCEDURE

To install the library follow these steps:
1. Insert the library CD into the appropriate drive. The installation screen appears 

in your HTML browser.

FIGURE 2-1: INSTALLATION SCREEN

2. Select Click to Install Files. A file download dialog appears, as shown in 
Figure 2-2.

Note: The installation uses your HTML browser and ActiveX controls. Depending 
on your browser settings, you may receive a security warning, which 
requires you to allow ActiveX controls to run during this session.
© 2008 Microchip Technology Inc. DS70134D-page 11
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FIGURE 2-2: FILE DOWNLOAD DIALOG

3. Click Save. The Save As dialog appears.
4. Specify a location to save the installation executable and click Save. 

The name of the installation executable varies depending on the license type. 
This example above reflects the name of the installation executable for the 
Evaluation version.

5. Browse to the saved location and double click the file to start the installation. The 
installation location dialog appears, which allows you to choose a directory 
location for the library.

FIGURE 2-3: INSTALLATION LOCATION DIALOG 
DS70134D-page 12 © 2008 Microchip Technology Inc.
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6. Browse to the directory of your choice, and then click OK. The License 
Agreement appears.

FIGURE 2-4: PROGRAM LICENSE AGREEMENT

7. Review the license agreement and then click OK to continue. The installation 
begins, showing its progress. Once all of the files have been installed, the 
Installation Complete dialog appears.

FIGURE 2-5: INSTALLATION COMPLETE DIALOG

8. Click OK to close the dialog. This completes the Acoustic Echo Cancellation 
Library installation.

The installation process creates the folder named EC v5.0, which contains the files 
described in Section 2.2 “Acoustic Echo Cancellation Library Files”.
© 2008 Microchip Technology Inc. DS70134D-page 13
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2.2 ACOUSTIC ECHO CANCELLATION LIBRARY FILES
The dsPIC DSC Acoustic Echo Cancellation Library CD creates a directory labeled 
EC v5.0. This directory contains these four folders:
• demo

• doc

• h

• lib

2.2.1 demo Folder
This folder contains files that are required by the dsPIC DSC Acoustic Echo 
Cancellation Library Quick Start Demonstration. Table 2-1 describes the files in this 
folders.

TABLE 2-1: DEMONSTRATION FILES
File Name Description

demo\EC demo2.hex Demonstration hexadecimal file for Board 2.

demo\EC demo.hex Demonstration hexadecimal file for Board 1.

demo\EC demo.mcp Demonstration MPLAB Project file.

demo\EC demo.mcw Demonstration MPLAB workspace.

demo\cleanup.bat A batch file script for cleaning the intermediate build 
files.

demo\h\dsPICDEM1_1Plus.h C header file for the dsPICDEM™ 1.1 Plus 
development board routines.

demo\h\lcd.h C header file defining the interface to the LCD 
driver.

demo\h\G711.h C header file defining the interface to the G.711 
library.

demo\h\ec_api.h C header file defining the interface to the Acoustic 
Echo Cancellation Library.

demo\h\UART1Drv.h C header file defining interface to UART driver.

demo\h\SI3000Drv.h C header file defining the interface to the Si3000 
Codec Driver.

demo\libs\eclibv5_0.a The Acoustic Echo Cancellation Library archive file.

demo\src\dsPICDEM1_1Plus.c C source files containing routines for the 
dsPICDEM1.1 Plus development board.

demo\src\lcd_strings.c C source files for LCD display driver.

demo\src\main.c C source files containing the main speech 
processing routine.

demo\src\UART1Drv.c C source file containing code for the UART 
peripheral.

demo\src\SI3000Drv.c C source file containing the code for the Si3000 
Codec.

demo\src\lcd.s Assembly routines for communicating with the LCD 
controller.

demo\src\G711.s Assembly routines implementing the G.711 library 
functions.
DS70134D-page 14 © 2008 Microchip Technology Inc.
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2.2.2 doc Folder
This folder contains the electronic user’s guide for the dsPIC DSC Acoustic Echo 
Cancellation Library. To view this document, double click the file name. The user’s 
guide can also be downloaded from the Microchip web site (www.microchip.com).

2.2.3 h Folder
This folder contains an include file for the Acoustic Echo Cancellation Library as listed 
in Table 2-2.

TABLE 2-2: INCLUDE FILE

2.2.4 lib Folder
This folder contains a library archive file for the Acoustic Echo Cancellation Library as 
listed in Table 2-3.

TABLE 2-3: LIBRARY FILE

File Name Description

ec_api.h Include file that contains the interface to the Acoustic Echo 
Cancellation Library. This file must be included in the 
application to use the library.

File Name Description

eclibv5_0.a This is the AEC Library archive file. This file must be 
included in the application in order to use the library.
© 2008 Microchip Technology Inc. DS70134D-page 15
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Chapter 3.  AEC Demonstration
This chapter provides a hands-on demonstration of acoustic echo cancellation in a 
working application. Topics covered include:
• Demonstration Summary
• Demonstration Setup
• Demonstration Procedure
• Demonstration Code Description

3.1 DEMONSTRATION SUMMARY
To demonstrate the functionality of the Acoustic Echo Cancellation (AEC) Library, a 
sample application emulating two speaker phones engaged in voice communication is 
provided with the Library. This software requires the use of two dsPICDEM™ 1.1 Plus 
development boards (not included with the software license), which are set up as 
shown in Figure 3-1.

FIGURE 3-1: ACOUSTIC ECHO CANCELLATION DEMONSTRATION

A speaker and a microphone are connected to dsPICDEM 1.1 Plus development board 1 
and are located in proximity to each other. A headset is connected to board 2.
When a person speaks into the headset connected to board 2, the speech signal is sam-
pled through the on-board Si3000 voice band codec and the Data Converter Interface 
(DCI) module of the dsPIC DSC device. The dsPIC DSC device then transmits the com-
pressed speech signal through its UART1 module and the on-board RS-232 transceiver 
to board 1.
The dsPIC DSC device on board 1 receives the signal through the on-board RS-232 
transceiver and the device’s UART1 module. The dsPIC DSC device then plays out the 
signal on the speaker through its DCI module and on-board Si3000 codec. 
Due to the proximity of the speaker to the microphone, the sound from the speaker enters 
the microphone and is sampled by the dsPIC DSC device through the codec. The device 
then transmits the microphone signal to board 2 via the RS-232 interface. If a person is 
talking into the microphone connected to board 1, the signal transmitted to board 2 is a 
combination of the near-end speech and the undesirable acoustic echo of the far-end 
speech. This combination of speech and echo can be heard on the headset connected 
to board 2. In this example, board 1 represents the near-end and board 2 represents the 
far-end.

dsPICDEM™ 1.1 Plus 
Running AEC Library

dsPICDEM 1.1 Plus 
Running AEC Library

Board 1 Board 2
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When started, the program initializes with acoustic echo cancellation turned OFF, 
indicated by LED1 being turned OFF and OFF being written to the LCD screen. With 
acoustic echo cancellation off, the signal heard in the headset connected to board 2 
contains noticeable echo.
Acoustic echo cancellation is enabled by pressing SW1. LED1 is now turned ON and ON 
is written to the LCD, and the speech signal heard on the headset connected to board 2 
becomes echo-free. 
The demonstration application program invokes the EC_apply and EC_applyNLP 
functions from the Acoustic Echo Cancellation Library to suppress the unwanted far-end 
echo mixed with the near-end speech.

3.2 DEMONSTRATION SETUP
The demo application is intended to run on a dsPICDEM 1.1 Plus development board 
(not included with the software license). 
Use the procedures outlined in the following sections to set up the demonstration.

3.2.1 Configure dsPICDEM 1.1 Plus Development Boards
Before applying power, configure the board:
1. Set jumper J9 (adjacent to the oscillator socket) to the SLAVE position (see 

Figure 3-2). This setting allows the on-board Si3000 codec chip to function as a 
serial clock Slave.

2. Connect the fold-up speaker to the SPKR OUT jack (J17) on board 1.
3. Connect the lapel microphone to the MIC IN jack (J16) on board 1. Make sure 

the microphone is turned on and is situated close enough to the speaker to gen-
erate feedback into the microphone.

4. Connect the headset microphone to the MIC IN (J16) jack on board 2.
5. Connect the headset speaker to the SPKR OUT (J17) jack on board 2. 
6. Connect one end of the DB9M-DB9M Null Modem Adapter to PORTB (J5) on 

board 1. Then, connect one end of the RS-232 cable to the Null Modem Adapter. 
7. Connect the other end of a 6 foot DB9 M/F RS-232 cable to the ‘PORTB’ (J5) port 

on board 2. 

FIGURE 3-2: DEMONSTRATION BOARD SETUP

3.2.2 Set Up the Demonstration
After both boards are properly configured, attach the speakers and microphones and 
interconnect the boards, as shown in Figure 3-3.

Set J9 to SLAVE
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FIGURE 3-3: CONNECT dsPICDEM™ 1.1 BOARDS

3.2.3 Program the dsPIC DSC Device
Use this process to load the acoustic echo cancellation demo into the dsPIC DSC 
device on the dsPICDEM 1.1 Plus development board.
1. On your PC, launch MPLAB IDE and open the EC demo.mcp project located in 

the demo folder. For more information on using MPLAB IDE, refer to the 
“MPLAB® IDE User’s Guide” (DS51025).

2. Import the project hexadecimal file: File>Import>EC demo.hex for board 1 or 
File>Import> EC demo2.hex for board 2.

3. From the Programmer menu, select Connect to link the MPLAB ICD 2 to the 
dsPIC DSC device target. The Output window shows that the MPLAB ICD 2 is 
ready.

4. From the Programmer menu, select Program. The Output window displays the 
download process and indicates that the programming has succeeded, as shown 
in Figure 3-4.

5. Connect the MPLAB ICD 2 to the dsPICDEM 1.1 Plus development board.
6. Program the dsPIC DSC device on the board.
7. When the program is loaded, disconnect the MPLAB ICD 2 from the board 

(remove the phone cable from the MPLAB ICD 2 connector). When you have 
done this, you will see the Acoustic Echo Cancellation information in the LCD 
display.

8. Repeat steps 2 through 7 for the second board.
9. Make sure that the two boards are not located too close to each other to avoid 

any acoustic coupling between the two boards.
The programming status is shown in Figure 3-4.

RS-232 Cable 

dsPICDEM™ 1.1 Plus 
development board 1 dsPICDEM 1.1 Plus 

development board 2

(J16) (J17)
SPKR OUTMIC INSPKR OUTMIC IN

(J16) (J17)

Null Modem Adapter115 
VAC

9 VDC

115 
VAC

9 VDC

ROUT

RIN

SOUT

J5 J5

Near-End Far-End

SIN
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FIGURE 3-4: PROGRAMMING STATUS IN OUTPUT WINDOW
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3.3 DEMONSTRATION PROCEDURE
After the demonstration application has been programmed into both devices the appli-
cation is now ready to run. Use the following procedure to run the demonstration:
1. Press the Reset button on Board 1. Wait till LED1 through LED4 on Board 1 turn 

ON. Now Reset Board 2. Wait till LED1 through LED4 on Board 1 and 2 turn 
OFF. This indicates that the boards are synchronized and the demo is running.

2. Put on the headset connected to dsPICDEM 1.1 Plus development board 2.
3. Start talking on the microphone input of the headset. You should observe the top 

bar of the VU meter rising and falling in time with your speech. This will be mim-
icked by the second bar of the VU meter on board 1. On the speaker output of 
the headset, you should be able to hear an echo of your own speech.

4. If you want, have someone simultaneously talk into the microphone connected 
to dsPICDEM 1.1 Plus development board 1. In this case, you will hear the other 
person’s speech as well as an echo of your own speech.

5. Press the switch marked ‘SW1’ on dsPICDEM 1.1 Plus development board 1. 
Observe that the LED1 on board 1 turns on, indicating that the AEC algorithm is 
active.

6. Again, speak into the microphone of the headset. You should no longer hear the 
echo of your own speech.

7. To observe acoustic echo cancellation during double talk, let a person simultane-
ously talk into the microphone connected to dsPICDEM 1.1 Plus development 
board 1. You will only hear the other person’s speech, free of the echo of your 
own speech. You will be able to experience the difference in ease of conversation 
by switching the echo canceller on and off while you and the other person are 
talking normally.

To experiment with different values of echo tail length, change the EC_ECHOTAIL 
constant defined in the ec_api.h include file, rebuild EC demo.mcp, reprogram board 
1 and rerun the demo application. The demo application relays the state of operation 
via the LEDs and the LCD.
While the application is loading and initializing the on-chip and off-chip peripherals, a 
boot screen is displayed. This is then switched to the run screen (see Figure 3-5).

FIGURE 3-5: DEMONSTRATION RUN-TIME LCD SCREEN ON BOARD 1

The run-time screen displays the following:
1. The name of the algorithm.
2. SW1 is used to turn Acoustic Echo Cancellation ON and OFF. SW4 is used to 

re-initialize the Acoustic Echo Cancellation algorithm.
3. The current state of the algorithm (Off) and the NLP level selected.
4. A VU meter showing the input levels. The top bar represents the nearEndIn 

buffer, the bottom bar represents the farEndIn buffer. The bands show an 
acceptable input range. CLIPPED is displayed when either input signal is too 
large.

The amount of Nonlinear Processing can be increased in 6 dB steps (up to 90 dB) by 
pressing SW3. It can be reduced in 6 dB steps (down to 0 dB) by pressing SW2. The 
default level for most applications is 18 dB.

Echo Cancellation
OnOff SW1 : Init SW4
Off : 18db NLP

* CLIPPED
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The Acoustic Echo Cancellation can be re-initialized by pressing SW4.

3.4 DEMONSTRATION CODE DESCRIPTION
The demonstration code runs on a dsPIC DSC device, using the primary oscillator as 
the clock source with the PLL set for 40 MIPS operation.
The file, main.c, contains the main function for the demo application. This main 
function allocates all the variables and arrays in data memory that are needed for DCI 
data buffering, as well as the blocks of data memory that need to be allocated for the 
AEC Library functions.
The main function calls the EC_init() function from the AEC Library, which initializes 
the AEC algorithm to its default state.
The main function also calls the SI3000_open() function to initialize the DCI module, 
the Si3000 codec, and the DCI interrupt. The DCI module acts as a Master and drives 
the serial clock and frame synchronization lines. The Si3000 codec acts as a Slave. 
The DCI module is set for the multi-channel Frame Sync Operating mode, with 16-bit 
data words and 16 data words or time slots per frame, of which only one transmit slot 
and one receive slot are used in this demonstration.
Subsequently, this function initializes the Si3000 codec. The codec is reset, by 
connecting the RF6 pin of the dsPIC DSC device to the Reset pin of the Si3000, holding 
RF6 low for 100 cycles and then bringing it high. The codec is configured for a sample 
rate of 8 kHz. The MIC Gain is set to 10 dB and the Receive Gain is set to 0 dB. Both 
speakers are set to Active and the Transmit Gain is set to 0 dB. The Analog Attenuation 
parameter is set to 0 dB. After initializing all of the Si3000 control registers, a delay is 
introduced for calibration of the Si3000 to occur. Finally, the DCI interrupt is enabled.
UART initialization and data processing is performed by the UART1_open() function. 
The UART module is configured to generate an interrupt for every byte transmitted or 
received. The UART module is run at a baud rate of ~250000 bps, with an 8-bit, no 
parity, 1 Stop bit data format (8-N-1). In the UART Transmit and Receive Interrupt 
Service Routines, the corresponding interrupt flag is cleared, data is either written to 
U1TXREG, or read from U1RXREG and saved in a circular buffer. 
The codec driver is read for a full frame of data. The contents of the coded data buffers 
are copied into the nearEndIn array and the EC_apply() function from the AEC 
Library is called with nearEndIn as the input data frame. The nearEndIn data buffer, 
which is also the output of the EC_apply function after it has been executed, is 
transferred to the UART for transmission to board 2. The UART data is converted from 
µ-Law to 16-bit linear and stored in farEndIn, which is the reference (echo) input data 
frame to EC_apply().
The display on the LCD is made possible by initialization of the SPI module in the 
InitSPI function, and LCD driver functions and LCD string definitions present in the 
lcd.s and lcd_strings.c files, respectively. 
To toggle the Acoustic Echo Cancellation ON or OFF, external interrupts for SW1 are 
enabled. In the main loop, the value of applyAEC is read and passed to EC_apply() 
as the enable flag. If applyAEC is ‘0’, the Acoustic Echo Cancellation is still called, but 
the input/output buffer is not changed. This enables the Acoustic Echo Cancellation to 
maintain adaptation to changes in echo path, while it is not enabled.
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Chapter 4.  Application Programming Interface (API)
This chapter describes in detail the Application Programming Interface to the dsPIC 
DSC Acoustic Echo Cancellation Library. Topics covered include:
• Adding the Acoustic Echo Cancellation Library to an Application
• Memory Model Compile Options
• AEC Algorithm Overview
• Library Usage
• Resource Requirements
• Acoustic Echo Cancellation Library API Functions
• Application Tips

4.1 ADDING THE ACOUSTIC ECHO CANCELLATION LIBRARY TO AN 
APPLICATION

To use the Acoustic Echo Cancellation Library in an application, the library archive 
must be added to the application project workspace and the file, ec_api.h, must be 
included in application code. Use following procedure to add the library to the 
application.
1. In the application MPLAB Workspace, right-click Library Files in the Project 

Window and select Add files.

FIGURE 4-1:

2. Browse to the location of the eclibv5_0.a file (available in the libs folder in 
the installation directory). 

3. Select the file and click Open (Figure 4-2).
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FIGURE 4-2:

4. The library is now added to the application.

FIGURE 4-3:

To use the library functions, include the file, ec_api.h, in the application source code. 
This file can be copied from the h folder (located in the installation directory) to the 
application project folder.
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4.2 MEMORY MODEL COMPILE OPTIONS
While using the AEC Library with the 128 ms tail length option in an application, the 
compiler should be directed to use a large memory model, as described in the following 
steps.
1. From the MPLAB IDE menu, select Project>Build Options>Project as shown in 

Figure 4-4.

FIGURE 4-4:

2. Click the MPLAB C30 tab and set the following options:
a) From the Categories drop-down list, select Memory Model, as shown in 

Figure 4-5.
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FIGURE 4-5:

b) In the Data Model section, select Large data model, as shown in Figure 4-6.
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FIGURE 4-6:

3. Click Apply, and then click OK.
This completes the procedure.
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4.3 AEC ALGORITHM OVERVIEW
This section describes the Acoustic Echo Cancellation (AEC) algorithm. A conceptual 
block diagram illustrating the operation of the AEC algorithm is shown in Figure 4-7.

FIGURE 4-7: AEC ALGORITHM FUNCTIONAL BLOCKS

The AEC algorithm can be divided into these functions:
• Normalized Least Mean Square (NLMS) Adaptive Filter
• Double Talk Detector (DTD)
• Nonlinear Processor (NLP)
• Howling Control
A typical AEC system involves these four signals:
• Far-end speech receive input (RIN)
• Near-end speech send output (SOUT)
• Far-end speech output (ROUT), usually sent to a local speaker
• Near-end speech input (SIN), usually received from a local microphone
The systems in which the near-end speaker and microphone do not have sufficient 
acoustic separation, the SIN signal not only contains the microphone input (presumably 
spoken by a talker at the near-end), but also an undesirable echo generated by the 
acoustic path from the speaker to the microphone. This signal is then transmitted to the 
far-end through the communication channel (wired or wireless), with the result that the 
listener at the other end hears a perceptible echo of his/her own speech. Traditionally, 
this problem was avoided by allowing only one person to talk at any given time (i.e., by 
not allowing “double talk”).
An acoustic echo cancellation algorithm consists of an adaptive filter and various asso-
ciated control functions, which not only eliminate the acoustic echo but also enables 
double talk (i.e., full-duplex operation). This algorithm operates at the same communi-
cating node at which the echo was generated. The control functions used in the AEC 
algorithm, in conjunction with the NLMS adaptive filter, are Double Talk Detector, 
Nonlinear Processor, and Howling Control. 

Normalized 
Least Mean 

Square 
(NLMS)

Adaptive Filter

  Nonlinear 
Processor 

(NLP)
Howling Control

Double Talk 
Detector

SIN

ROUT RIN

SOUT

Acoustic path 
from speaker to 
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 (DTD)
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4.3.1 Normalized Least Mean Square (NLMS) Adaptive Filter
NLMS is the fundamental adaptation algorithm used for estimating and canceling out 
the acoustic echo. This filter tries to minimize the mean square error between the SIN 
and RIN signals. Under conditions where there is no double talk, this will result in a set 
of filter coefficients that approximate the acoustic path between the speaker and the 
microphone. The filter thereby produces an echo estimate of RIN, which is then 
subtracted from the SIN signal. 

4.3.2 Nonlinear Processor (NLP)
The AEC algorithm by itself may not be capable of adequately modeling echo paths 
that generate significant levels of nonlinear distortion. This necessitates the usage of a 
Nonlinear Processor. The function of the NLP is to substantially suppress the residual 
echo level which remains at the output of the NLMS adaptive filter, so that a very-low 
returned echo level can be achieved even if the echo path is nonlinear. The NLP is 
located in the send path between the output of the NLMS filter and the SOUT port of the 
system. The NLP basically attenuates low-level signals (which are assumed to be 
residual echo) and passes high-level signals (which are assumed to be desirable 
near-end speech).
The AEC library offers two functions for using the NLP. The EC_applyNLP() function 
applies the NLP action to the input buffer. The EC_setNLPLevel() function varies the 
level of attenuation.

4.3.3 Howling Control
Howling is a typical problem in full-duplex communication. It builds up due to the acous-
tic feedback path. One way to reduce howling is to shift the frequency of the signal that 
is picked up by the microphone by 10 Hz to 20 Hz, before it is sent out over a commu-
nication channel. This shift is usually not perceived as unnatural by the human ear. The 
shifted signal appears at the destination loudspeakers and travels back to the origina-
tor, shifted by another 10 Hz to 20 Hz. The signal travels many times through this 
acoustic path and is quickly shifted out of the pass band, thereby reducing the problem 
of unpleasant feedback. 
The AEC library offers a function, EC_setHowlingControl(), to enable and disable 
howling control.

4.3.4 Double Talk Detector (DTD)

Double talk is the condition that occurs as a result of two talkers on both sides (RIN and 
SIN) talking at the same time. During double talk, the signal SIN acts like uncorrelated 
noise and may cause the coefficients of the NLMS adaptive filter to diverge, thereby 
failing to effectively cancel the acoustic echo. To prevent such a condition, a Double 
Talk Detector (DTD) is used to inhibit adaptation of the filter during periods of simulta-
neous far-end and near-end speech. The DTD also inhibits the operation of the NLP to 
prevent loss of near-end speech. In this algorithm, an energy-based double talk detec-
tor is used, in which double talk is detected when Average Energy of SOUT > Average 
Energy of RIN.
The AEC library offers two functions, EC_setDoubleTalkHangover() and 
EC_setAdaptionHangover(), to control the amount of DTD hangover. The double 
talk hangover represents the number of frames after double talk has been detected for 
which the AEC algorithm will wait before resuming application of NLP. For example, if 
the hangover value is 6, the algorithm will wait for 6 frames before applying NLP again.
The adaptation hangover is controlled by EC_setAdaptionHangover(). The default 
value for this function is ‘1’, so that adaptation resumes one frame after the end of 
double talk.
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4.4 LIBRARY USAGE
The AEC algorithm has been designed to be usable in a re-entrant environment. This 
enables the algorithm to process many independent channels of audio, each channel 
having its own setting and parameters.
The following coding steps need to be performed to enable use of the Acoustic Echo 
Cancellation Library:
1. Set the Echo Tail Length: In the file ec_api.h, set the EC_ECHOTAIL value to 

the desired echo tail length. The valid values are 8, 16, 32, 64 and 128 msec. 
Note that setting a invalid value will cause the EC_init() function to return a 
EC_ORDERERROR value. This coding step is shown in Example 4-1.

EXAMPLE 4-1: 

Steps 2 through 6 should be performed in the user application. Refer to 
Example 4-2 for the actual code required. 

2. Allocate the memory for the AEC algorithm state holder: This memory is an 
integer array in X memory aligned at an address boundary of 2 bytes. The 
EC_XSTATE_MEM_SIZE_INT macro specifies the size of this array. Every audio 
channel to be processed will requires it own state holder.

3. Allocate the memory for the AEC algorithm X and Y scratch memories: The 
X scratch memory is an integer array in X memory aligned at an address bound-
ary of 4 bytes. The Y scratch memory is an integer array in Y memory aligned at 
an address boundary of 2 bytes. Multiple audio channels can share the same 
scratch memories. 

4. Initialize the acoustic echo cancellation algorithm state for each audio 
channel: Use the EC_init() function for initializing the acoustic echo 
cancellation state for each audio channel.

5. Apply the Acoustic Echo Cancellation to an audio frame: Use the 
EC_apply() function to perform echo cancellation on an audio frame. If a frame 
is not required to be processed by the AEC algorithm, the function should still be 
called with the enable parameter set to EC_FALSE. This will allow the AEC 
algorithm to continue adapting to the echo in the audio frame. The audio frame 
stays unaffected. 

6. Use the NLP function: Use the EC_applyNLP() function to suppress residual 
echo.

.

.

.
#ifndef __EC_API_H__
#define __EC_API_H__

/* Set the desired echo tail length */
#define EC_ECHOTAIL 64 /* Step 1 */

// Nothing below this line should be changed
#define EC_FRAME 80
#define EC_FALSE 0
#define EC_TRUE 1
.
.
.
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EXAMPLE 4-2: 

4.5 RESOURCE REQUIREMENTS
The Acoustic Echo Cancellation Library requires the following resources while running 
on the dsPIC DSC device.

4.5.1 Program Memory Usage

TABLE 4-1:

4.5.2 Data Memory Usage (64 ms Echo Tail Length)

TABLE 4-2:

// Channel 1 memory structures.
int ecStateMemX1 [EC_XSTATE_MEM_SIZE_INT] _XBSS(2); /* Step 2 */

// Channel 2 memory structures
int ecStateMemX2 [EC_XSTATE_MEM_SIZE_INT] _XBSS(2); /* Step 2 */

// Each instance can share the same X and Y scratch memory
int ecScratchX [EC_XSCRATCH_MEM_SIZE_INT] _XBSS(2); /* Step 3 */
int ecScratchY [EC_YSCRATCH_MEM_SIZE_INT] _YBSS(2); /* Step 3 */
.
.
.
void main()
{

EC_init(ecStateMemX1, ecScratchX, EC_ORDER); /* Step 4 */
EC_init(ecStateMemX2, ecScratchX, EC_ORDER); /* Step 4 */
.
.
.
While(1)
{

EC_apply(ecStateMemX1, ecScratchY, nearEndIn1, farEndIn1, EC_TRUE); /* Step 5 */
EC_applyNLP(ecStateMemX1, nearEndIn1, EC_TRUE); /* Step 6 */

EC_apply(ecStateMemX2, ecScratchY, nearEndIn2, farEndIn2, EC_TRUE); /* Step 5 */
EC_applyNLP(ecStateMemX2, nearEndIn2, EC_TRUE); /* Step 6 */

}
}

Type Size (bytes) Section

Code in Program Memory 6753 .libec

Tables in Program Memory 2154 .const

Total Program Memory 8907 —

Function Size (bytes) Alignment Section

ecStateMemX 2240 2 X data memory

scratchMemX 1504 2 X data memory

scratchMemY 1184 2 Y data memory

nearEndIn 160 2 X or Y data memory

farEndIn 160 2 X or Y data memory

Total Data Memory 5248 — —
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4.5.3 Estimated Dynamic Memory Usage

TABLE 4-3:

4.5.4 Computational Speed

TABLE 4-4:

4.5.5 Data Format
The data type of nearEndIn and farEndIn can be 10-, 12- or 16-bit linear PCM data. 
The AEC algorithm automatically adjusts for the data format used.

Section Size (bytes)

Heap 0
Stack < 300

Function Echo Tail MIPS Typical Call Frequency

EC_init() All < 0.5 Once

EC_apply() + EC_applyNlP() 8 4.5 10 ms

EC_apply() + EC_applyNlP() 16 6 10 ms

EC_apply() + EC_applyNlP() 32 9.5 10 ms

EC_apply() + EC_applyNlP() 64 16 10 ms

EC_apply() + EC_applyNlP() 128 21 10 ms

All other functions All Minimal As required
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4.6 ACOUSTIC ECHO CANCELLATION LIBRARY API FUNCTIONS
This section lists and describes the Application Programming Interface (API) functions 
that are available in the dsPIC DSC Acoustic Echo Cancellation Library. The functions 
are listed below followed by their individual detailed descriptions.
• EC_init

• EC_relocateXScratchMem

• EC_apply

• EC_applyNLP

• EC_setNLPLevel

• EC_getNLPLevel

• EC_setDoubleTalkHangover

• EC_getDoubleTalkHangover

• EC_setAdaptionHangover

• EC_getAdaptionHangover

• EC_setHowlingControl

• EC_getHowlingControl

• EC_setForceAdapt

• EC_getForcedAdapt

• EC_setInhibitAdaption

• EC_getInhibitAdaption

• EC_estimateERLE

• EC_TRUE

• EC_FALSE

• EC_FRAME

• EC_ECHOTAIL

• EC_ORDER

• EC_XSTATE_MEM_SIZE_INT

• EC_XSCRATCH_MEM_SIZE_INT

• EC_YSCRATCH_MEM_SIZE_INT

• EC_DOUBLETALKHANGOVERDEFAULT

• EC_ADAPTIONHANGOVERDEFAULT

• EC_NLPLEVELDEFAULT

• EC_HOWLINGCONTROLDEFAULT

• EC_FORCEADAPTDEFAULT

• EC_ORDERERROR

• EC_OK
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EC_init

Description
Initializes the AEC algorithm.

Include
ec_api.h

Prototype
int EC_init(int* ptrStateX, int* xScratchMem, int order);

Arguments
ptrStateX a pointer to the state memory for this instance of AEC
xScratchMem a pointer to an area of scratch memory in X RAM used by

the AEC algorithm
order an integer representing the filter order (EC_ORDER)

Return Value
EC_OK If the value of EC_ORDER is correct
EC_ORDERERROR If the value of EC_ORDER is incorrect

Remarks
The value of order can be set to EC_ORDER, which is a macro in ec_api.h that 
calculates the filter order based on the echo tail length required.

Code Example
int ecStateMemX [EC_XSTATE_MEM_SIZE_INT] _XBSS(2); 
int ecScratchX [EC_XSCRATCH_MEM_SIZE_INT] _XBSS(2);
int ecScratchY [EC_YSCRATCH_MEM_SIZE_INT] _YBSS(2);
.
.
.
EC_init(ecStateMemX, ecScratchX, EC_ORDER);
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EC_relocateXScratchMem

Description
Changes the X scratch memory buffer used by the AEC algorithm.

Include
ec_api.h

Prototype
void EC_relocateXScratchMem(int* ptrStateX, int* xScratchMem);

Arguments
ptrStateX a pointer to the state memory for this instance of AEC
xScratchMem a pointer to the new X scratch memory to be used by the AEC

algorithm

Return Value
None.

Remarks
After relocating the X scratch memory, the older scratch memory is not used by the 
AEC Library.

Code Example
int ecStateMemX [EC_XSTATE_MEM_SIZE_INT] _XBSS(2); 
int ecScratchX [EC_XSCRATCH_MEM_SIZE_INT] _XBSS(2);
int ecScratchX2 [EC_XSCRATCH_MEM_SIZE_INT] _XBSS(2);
int ecScratchY [EC_YSCRATCH_MEM_SIZE_INT] _YBSS(2);
.
.
.
EC_init(ecStateMemX, ecScratchX, EC_ORDER);

The AEC Algorithm is using ecScratchX for its scratch memory.
.
.
.
EC_relocateXScratchMem(ecStateMemX, ecScratchX2);

The AEC Algorithm is now using ecScratchX2 for its scratch memory.
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EC_apply

Description
Applies acoustic echo cancellation to the current frame of data.

Include
ec_api.h

Prototype
void EC_apply(int* ptrStateX, int* yScratchMem, int* nearEndIn, 
int* farEndIn, int enable);

Arguments
ptrStateX a pointer to the X memory for this instance of AEC
yScratchMem a pointer to an area of scratch memory in Y RAM used by

the AEC algorithm
nearEndIn a pointer to the near-end speech input (SIN) signal on buffer of

size EC_FRAME. This buffer can be in X or Y memory
farEndIn a pointer to the far-end speech receive input (RIN) signal on

buffer of size EC_FRAME. This buffer can be in X or Y memory
enable a flag to indicate if AEC is required for this buffer

(EC_TRUE or EC_FALSE)

Return Value
None.

Remarks
The AEC algorithm is process-in-place, meaning that the output is passed back in the 
input buffer. Setting Enable to EC_FALSE returns an un-processed buffer of data, but 
the AEC algorithm still adapts on the data.

Code Example
int ecStateMemX [EC_XSTATE_MEM_SIZE_INT] _XBSS(2); 
int ecScratchY [EC_YSCRATCH_MEM_SIZE_INT] _YBSS(2);
int ecScratchX [EC_XSCRATCH_MEM_SIZE_INT] _XBSS(2);
.
.
.
EC_init(ecStateMemX, ecScratchX, EC_ORDER);
.
.
.
EC_apply(ecStateMemX, ecScratchY, nearEndIn, farEndIn, EC_TRUE);
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EC_applyNLP

Description
Applies NLP portion of the acoustic echo cancellation to the current frame of data.

Include
ec_api.h

Prototype
void EC_applyNLP(int* ptrStateX, int* nearEndIn, int enable);

Arguments
ptrStateX a pointer to the state memory for this instance of AEC
nearEndIn a pointer to the input/output buffer of size EC_FRAME
enable a flag to indicate if NLP is required for this buffer

(EC_TRUE or EC_FALSE)

Return Value
None.

Remarks
None.

Code Example
int ecStateMemX [EC_XSTATE_MEM_SIZE_INT] _XBSS(2); 
int ecScratchY [EC_YSCRATCH_MEM_SIZE_INT] _YBSS(2);
int ecScratchX [EC_XSCRATCH_MEM_SIZE_INT] _XBSS(2);
.
.
.
EC_init(ecStateMemX, ecScratchX, EC_ORDER);
.
.
.
EC_apply(ecStateMemX, ecScratchY, nearEndIn, farEndIn, EC_TRUE);
EC_applyNLP(ecStateMemX, nearEndIn, EC_TRUE);
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EC_setNLPLevel

Description
Sets the required level of NLP.

Include
ec_api.h

Prototype
void EC_setsetNLPLevel(int* ptrStateX, int level);

Arguments
ptrStateX a pointer to the state memory for this instance of AEC
level an integer value between 0 and 15 representing the desired NLP

level

Return Value
None.

Remarks
Each value represents a 6 dB change in the NLP level. Therefore, a value of 3 
translates to an NLP level of 18 dB.

Code Example
EC_setNLPLevel(ecStateMemX, 3);

Sets the desired NLP level to 3 for the instance of the algorithm ecStateMemX.
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EC_getNLPLevel

Description
Returns the current NLP level.

Include
ec_api.h

Prototype
int EC_getNLPLevel(int* ptrStateX);

Arguments
ptrStateX a pointer to the state memory for this instance of AEC

Return Value
The current NLP level as an integer for the instance of the algorithm ecStateMemX.

Remarks
None.

Code Example
int nlpLevel;
nlpLevel = EC_getNLPLevel(ecStateMemX);

nlpLevel contains the current NLP level for the instance of the algorithm 
ecStateMemX.
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EC_setDoubleTalkHangover

Description
Sets the hangover value for the double talk detection portion of the AEC algorithm.

Include
ec_api.h

Prototype
void EC_setDoubleTalkHangover(int* ptrStateX, int frames);

Arguments
ptrStateX a pointer to the state memory for this instance of AEC
frames an integer value from 1 to 100 representing the desired double talk

hangover

Return Value
None.

Remarks
The double talk hangover is used to adjust the hysteresis around the double talk detec-
tion. A larger value keeps the double talk detection active longer. Setting double talk 
hangover to ‘1’ disables the hysteresis. 

Code Example
EC_setDoubleTalkHangover(ecStateMemX, 10);

Sets the desired double talk hangover to 10 frames (representing 100 ms of data) for 
the instance of the algorithm ecStateMemX.
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EC_getDoubleTalkHangover

Description
Returns the current double talk detection hangover.

Include
ec_api.h

Prototype
int EC_getDoubleTalkHangover(int* ptrStateX);

Arguments
ptrStateX a pointer to the state memory for this instance of AEC

Return Value
The current double talk detection hangover value.

Remarks
None.

Code Example
int doubleTalkHangover;
doubleTalkHangover = EC_getDoubleTalkHangover(ecStateMemX);

doubleTalkHangover contains the double talk detection hangover value set for the 
instance of the algorithm ecStateMemX.
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EC_setAdaptionHangover

Description
Sets the hangover value for the adaptation update portion of the AEC algorithm.

Include
ec_api.h

Prototype
void EC_setAdaptionHangover(int* ptrStateX, int frames);

Arguments
ptrStateX a pointer to the state memory for this instance of AEC
frames an integer value from 1 to 100 representing the adaptation hangover

Return Value
None.

Remarks
The adaptation hangover is used to adjust the hysteresis around the adaptation 
update. A larger value keeps the adaptation update active longer. Setting adaptation 
hangover to ‘1’ disables the hysteresis.

Code Example
EC_setAdaptionHangover(ecStateMemX, 3);

Sets the desired adaptation hangover to 3 frames (representing 30 ms of data) for the 
instance of the algorithm ecStateMemX.
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EC_getAdaptionHangover

Description
Returns the current adaptation hangover.

Include
ec_api.h

Prototype
int EC_getAdaptionHangover(int* ptrStateX);

Arguments
ptrStateX a pointer to the state memory for this instance of AEC

Return Value
The current adaptation hangover value.

Remarks
None.

Code Example
int adaptionHangover;
adaptionHangover = EC_getAdaptionHangover(ecStateMemX);

adaptionHangover contains the adaptation hangover value set for the instance of 
the algorithm ecStateMemX.
© 2008 Microchip Technology Inc. DS70134D-page 43



dsPIC® DSC Acoustic Echo Cancellation Library User’s Guide
EC_setHowlingControl

Description
Enables or disables the howling control.

Include
ec_api.h

Prototype
void EC_setHowlingControl(int* ptrStateX, int howlingControl);

Arguments
ptrStateX a pointer to the state memory for this instance of AEC
howlingControl a flag to indicate if howling control is required

(EC_TRUE or EC_FALSE)

Return Value
None.

Remarks
None.

Code Example
EC_setHowlingControl(ecStateMemX, EC_TRUE);

Enables the howling control for the instance of the algorithm ecStateMemX.
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EC_getHowlingControl

Description
Returns the current state of the howling control.

Include
ec_api.h

Prototype
int EC_getHowlingControl(int* ptrStateX);

Arguments
ptrStateX a pointer to the state memory for this instance of AEC

Return Value
Returns the current state of howling control.

Remarks
None.

Code Example
int howlingControl;
howlingControl = EC_getHowlingControl(ecStateMemX);

howlingControl contains the howling control state set for the instance of the 
algorithm ecStateMemX.
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EC_setForceAdapt

Description
Enables or disables the forced adaptation of the AEC algorithm.

Include
ec_api.h

Prototype
void EC_setForceAdapt(int* ptrStateX, int state);

Arguments
ptrStateX a pointer to the state memory for this instance of AEC
state either EC_TRUE or EC_FALSE

Return Value
None.

Remarks
None.

Code Example
EC_setForceAdapt(ecStateMemX, EC_TRUE);

Sets forced adaptation for the instance of the algorithm ecStateMemX.
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EC_getForcedAdapt

Description
Returns the state of the forced adaptation.

Include
ec_api.h

Prototype
int EC_getForceAdapt(int* ptrStateX);

Arguments
ptrStateX a pointer to the state memory for this instance of AEC

Return Value
The current state of forced adaptation.

Remarks
None.

Code Example
int forceAdapt;
forceAdapt = EC_getForceAdapt(ecStateMemX);

forceAdapt contains the forced adaptation value set for the instance of the algorithm 
ecStateMemX, either EC_TRUE or EC_FALSE.
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EC_setInhibitAdaption

Description
Sets the state of the inhibit adaptation.

Include
ec_api.h

Prototype
void EC_setInhibitAdaption(int* ptrStateX, int state);

Arguments
ptrStateX a pointer to the state memory for this instance of AEC
state either EC_TRUE or EC_FALSE

Return Value
None.

Remarks
None.

Code Example
EC_setInhibitAdaption(ecStateMemX, EC_TRUE);

Prevents adaptation of the instance of the algorithm ecStateMemX.
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EC_getInhibitAdaption

Description
Returns the state of the inhibit adaptation.

Include
ec_api.h

Prototype
long EC_getInhibitAdaption(int* ptrStateX);

Arguments
ptrStateX a pointer to the state memory for this instance of AEC

Return Value
EC_TRUE If adaptation is inhibited
EC_FALSE If adaptation is not inhibited

Remarks
None.

Code Example
long inhibitAdaption;
inhibitAdaption = EC_getInhibitAdaption(ecStateMemX);

inhibitAdaption contains the inhibit adaptation value set for the instance of the 
algorithm ecStateMemX, either EC_TRUE or EC_FALSE.
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EC_estimateERLE

Description
Estimates the Echo Return Loss Enhancement (ERLE).

Include
ec_api.h

Prototype
int EC_estimateSNR(int* preEC, int* postEC);

Arguments
preEC a pointer to the buffer of data before the AEC algorithm has been

applied
postEC a pointer to the buffer of data after the AEC algorithm has been

applied

Return Value
An estimate of the ERLE.

Remarks
This is a crude estimate of the ERLE of the current frame of data.

Code Example
int erle;
for (i = 0; i < EC_FRAME; i++)
{
   nearEndBefore[i] = nearEndIn[i];
}
EC_apply(ecStateMemX, ecScratchY, nearEndIn, farEndIn, EC_TRUE);
EC_applyNLP(ecStateMemX, nearEndIn, EC_TRUE);
erle = EC_estimateSNR(nearEndBefore, nearEndIn);

erle contains the estimate of the ERLE (in dB).
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EC_TRUE

Description
Used to indicate true to the AEC algorithm.

Value
1

EC_FALSE

Description
Used to indicate false to the AEC algorithm.

Value
0

EC_FRAME

Description
The size of the input buffer processed.

Value
80

EC_ECHOTAIL

Description
The length of the echo tail length required (8, 16, 32, 64 or 128 ms).

Value
64
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EC_ORDER

Description
The size of the input buffer processed.

Value
(EC_ECHOTAIL * 8)

EC_XSTATE_MEM_SIZE_INT

Description
Size in integers of the memory location required for the X-State memory.

Value
((EC_ORDER * 2) + 96)

EC_XSCRATCH_MEM_SIZE_INT

Description
Size in integers of the memory location required for the X-Scratch memory.

Value
(EC_ORDER + (EC_FRAME * 3))

EC_YSCRATCH_MEM_SIZE_INT

Description
Size in integers of the memory location required for the Y-Scratch memory.

Value
(EC_ORDER + EC_FRAME)
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EC_DOUBLETALKHANGOVERDEFAULT

Description
Value in frames for the double talk hangover.

Value
3

EC_ADAPTIONHANGOVERDEFAULT

Description
Value in frames for the default adaptation hangover.

Value
1

EC_NLPLEVELDEFAULT

Description
Value of the default NLP attenuation (EC_NLPLEVELDEFAULT * 6 dB).

Value
3

EC_HOWLINGCONTROLDEFAULT

Description
Boolean value of the state of the howling control module.

Value
EC_FALSE
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EC_FORCEADAPTDEFAULT

Description
Boolean value to enable forced adaptation.

Value
EC_FALSE

EC_ORDERERROR

Description
Return value from EC_init to indicate that the specified order is not valid.

Value
0x8001

EC_OK

Description
Return value from EC_init to indicate that the specified order is valid.

Value
0x0000
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4.7 APPLICATION TIPS
Although the Acoustic Echo Cancellation algorithm makes a best effort to suppress the 
echo in a system, its performance can be optimized by proper selection of parameters.
In general, experimentation with this library is encouraged. Your feedback and com-
ments are welcome, as they help to guide the direction of future development.
Following are some tips for affecting the performance of the algorithm:
1. The optimum input signal levels for testing audio and communication systems 

are generally considered to lie between -10 dBm0 and -30 dBm0. If digital input 
speech levels have peaks that are up to three-fourths of full range, then good use 
is being made of the available precision; levels higher than this carry a risk of 
amplitude clipping.

2. Choose a NLP level that best fits the application. A very high NLP level not only 
suppresses the residual echo, but may also reduce the speech level to some 
extent.

3. The Double Talk Detection Hangover can be used to adjust the window during 
which the AEC algorithm will wait before applying NLP to the send signal. If the 
application is experiencing some leading edge speech clipping, then try increas-
ing the DTD Hangover.

4. The Adaptation Hangover can be used to adjust the window during which an 
adaptation hangover update stays active. This parameter can be adjusted in 
situations where the speech level is low and double talk may not be detected.

5. In cases where the near-end ambient acoustic environment is noisy (such as cell 
phones and automotive hands-free units), the noise level may cause the double 
talk detection to be activated, thereby inhibiting adaptation. In such cases, the 
AEC algorithm can be forced to adapt all the time which may improve the overall 
system performance.

6. The user application should never inhibit adaptation. This feature is only 
provided for test and compliance checking purposes.
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